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Preface

Preface

The Exploring Series and You

Exploring is Pearson’s Office Application series that requires students like you to think “beyond the point
and click.” In this edition, we have worked to restructure the Exploring experience around the way you,
today’s modern student, actually use your resources.

The goal of Exploring is, as it has always been, to go farther than teaching just the steps to accomplish
a task—the series provides the theoretical foundation for you to understand when and why to apply a
skill. As a result, you achieve a deeper understanding of each application and can apply this critical
thinking beyond Office and the classroom.

The How & Why of This Revision

Outcomes matter. Whether it’s getting a good grade in this course, learning how to use Excel so
students can be successful in other courses, or learning a specific skill that will make learners successful
in a future job, everyone has an outcome in mind. And outcomes matter. That is why we revised our
chapter opener to focus on the outcomes students will achieve by working through each Exploring
chapter. These are coupled with objectives and skills, providing a map students can follow to get
everything they need from each chapter.

Critical Thinking and Collaboration are essential 21st century skills. Students want and need
to be successful in their future careers—so we used motivating case studies to show relevance of these
skills to future careers and incorporated Soft Skills, Collaboration, and Analysis Cases with Critical
Thinking steps in this edition to set students up for success in the future.

Students today read, prepare, and study differently than students used to. Students use
textbooks like a tool—they want to easily identify what they need to know and learn it efficiently. We
have added key features such as Tasks Lists (in purple), Step Icons, Hands-On Exercise Videos, and
tracked everything via page numbers that allow efficient navigation, creating a map students can easily
follow.

Students are exposed to technology. The new edition of Exploring moves beyond the basics of the
software at a faster pace, without sacrificing coverage of the fundamental skills that students need to
know.

Students are diverse. Students can be any age, any gender, any race, with any level of ability or
learning style. With this in mind, we broadened our definition of “student resources” to include physical
Student Reference cards, Hands-On Exercise videos to provide a secondary lecture-like option of review;
and MyITLab, the most powerful and most ADA-compliant online homework and assessment tool
around with a direct 1:1 content match with the Exploring Series. Exploring will be accessible to all
students, regardless of learning style.

Providing You with a Map to Success to Move
Beyond the Point and Click

All of these changes and additions will provide students an easy and efficient path to follow to be
successful in this course, regardless of where they start at the beginning of this course. Our goal is to
keep students engaged in both the hands-on and conceptual sides, helping achieve a higher level of
understanding that will guarantee success in this course and in a future career.

In addition to the vision and experience of the series creator, Robert T. Grauer, we have assembled a
tremendously talented team of Office Applications authors who have devoted themselves to teaching
the ins and outs of Microsoft Word, Excel, Access, and PowerPoint. Led in this edition by series editor
Mary Anne Poatsy, the whole team is dedicated to the Exploring mission of moving students beyond
the point and click.



Key Features

The How/Why Approach helps students move beyond the point and click to a true understanding of
how to apply Microsoft Office skills.

*  White Pages/Yellow Pages clearly distinguish the theory (white pages) from the skills covered in
the Hands-On Exercises (yellow pages) so students always know what they are supposed to be doing
and why.

* Case Study presents a scenario for the chapter, creating a story that ties the Hands-On Exercises
together.

* Hands-On Exercise Videos are tied to each Hands-On Exercise and walk students through the
steps of the exercise while weaving in conceptual information related to the Case Study and the
objectives as a whole.

The Outcomes focus allows students and instructors to know the higher-level learning goals and how
those are achieved through discreet objectives and skills.

*  Outcomes presented at the beginning of each chapter identify the learning goals for students and
instructors.

* Enhanced Objective Mapping enables students to follow a directed path through each chapter,
from the objectives list at the chapter opener through the exercises at the end of the chapter.

* Objectives List: This provides a simple list of key objectives covered in the chapter. This includes
page numbers so students can skip between objectives where they feel they need the most help.

» Step Icons: These icons appear in the white pages and reference the step numbers in the Hands-
On Exercises, providing a correlation between the two so students can easily find conceptual help
when they are working hands-on and need a refresher.

* Quick Concepts Check: A series of questions that appear briefly at the end of each white
page section. These questions cover the most essential concepts in the white pages required for
students to be successful in working the Hands-On Exercises. Page numbers are included for easy
reference to help students locate the answers.

* Chapter Objectives Review: Appears toward the end of the chapter and reviews all important
concepts throughout the chapter. Newly designed in an easy-to-read bulleted format.

u *  MOS Certification Guide for instructors and students to direct anyone interested in prepping for
Watch the Video the MOS exam to the specific locations to find all content required for the test.
for this Hands-
On Exercise!

End-of-Chapter Exercises offer instructors several options for assessment. Each chapter has
approximately 11-12 exercises ranging from multiple choice questions to open-ended projects.

Multiple Choice, Key Terms Matching, Practice Exercises, Mid-Level Exercises, Beyond
the Classroom Exercises, and Capstone Exercises appear at the end of all chapters.

ANALYSIS 0

CASE *  Enhanced Mid-Level Exercises include a Creative Case (for PowerPoint and Word), which
CREATIVE allows students some flexibility and creativity, not being bound by a definitive solution, and an
Analysis Case (for Excel and Access), which requires students to interpret the data they are

CASE using to answer an analytic question, as well as Discover Steps, which encourage students to

use Help or to problem-solve to accomplish a task.

MylTLab®| |MylTLab®

HOE Training Grader Application Capstone exercises are included in the book to allow instructors to test students on

the entire contents of a single application.

Key Features




Resources

Resources

Instructor Resources

The Instructor’s Resource Center, available at www.pearsonhighered.com, includes the
following:

Instructor Manual provides one-stop-shop for instructors, including an overview of all available
resources, teaching tips, as well as student data and solution files for every exercise.

Solution Files with Scorecards assist with grading the Hands-On Exercises and end-of-chapter
exercises.

Prepared Exams allow instructors to assess all skills covered in a chapter with a single project.

Rubrics for Mid-Level Creative Cases and Beyond the Classroom Cases in Microsoft Word format
enable instructors to customize the assignments for their classes.

PowerPoint Presentations with notes for each chapter are included for out-of-class study or
review.

Multiple Choice, Key Term Matching, and Quick Concepts Check Answer Keys
Test Bank provides objective-based questions for every chapter.
Scripted Lectures offer an in-class lecture guide for instructors to mirror the Hands-On Exercises.

Syllabus Templates

¢ QOutcomes, Objectives, and Skills List
¢ Assignment Sheet

¢ File Guide

Student Resources

Student Data Files

Access your student data files needed to complete the exercises in this textbook at
www.pearsonhighered.com/exploring.

Available in MylTLab

Hands-On Exercise Videos allow students to review and study the concepts taught in the Hands-
On Exercises.

Audio PowerPoints provide a lecture review of the chapter content, and include narration.
Multiple Choice quizzes enable you to test concepts you have learned by answering auto-graded
questions.

Book-specific 1:1 Simulations allow students to practice in the simulated Microsoft Office 2016
environment using hi-fidelity, HTML5 simulations that directly match the content in the Hands-On
Exercises.

eText available in some MyITLab courses and includes links to videos, student data files, and other
learning aids.

Book-specific 1:1 Grader Projects allow students to complete end-of-chapter Capstone Exercises
live in Microsoft Office 2016 and receive immediate feedback on their performance through various
reports.



(ex-ploring)

1. Investigating in a systematic way: examining. 2. Searching into
or ranging over for the purpose of discovery.

Microsoft

Excel 2016

COMPREHENSIVE
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Features

Common Features

LEARNING You will apply skills common across the Microsoft Office suite to create and format
OUTCOME documents and edit content in Office 2016 applications.

OBJECTIVES & SKILLS: After you read this chapter, you will be able to:

Getting Started with Office Applications OBJECTIVE 8: RELOCATE TEXT 30
Cut, Copy, and Paste Text; Use the Office Clipboard
OBJECTIVE 1: START AN OFFICE APPLICATION 4 OBJECTIVE 9: CHECK SPELLING AND GRAMMAR 32
Open a Microsoft Office Application, Change Your Check Spelling and Grammar
Microsoft Account OBJECTIVE 10: WORK WITH PICTURES AND GRAPHICS 34
OBJECTIVE 2: WORK_ WITH FILES . . 5 Insert Pictures and Graphics, Resize and Format
Create a New File, Open a File, Save a File Pictures and Graphics
OBJECTIVE 3: USE COMMON INTERFACE COMPONENTS 8

HANDS-ON EXERCISE 2:

Use the Ribbon, Use a Shortcut Menu, Use Keyboard
Format Document Content 37

Shortcuts, Customize the Ribbon, Use the Quick
Access Toolbar, Customize the Quick Access Toolbar

OBJECTIVE 4: GET HELP 15 Modify Document Layout and Properties

Use the Tell me what you want to do Box, Use

] OBJECTIVE 11: USE BACKSTAGE VIEW 42
Enhanced ScreenTips C ize Apolication Obti E D
OBJECTIVE 5: INSTALL ADD-INS 17 Pus’com!ze pplication Options, Enter Document
Use an Add-in from the Store roperties
OBJECTIVE 12: CHANGE THE DOCUMENT VIEW a4
HANDS-ON EXERCISE 1: Change the Document View

Change Margins, Change Page Orientation, Use the

Format Document Content Page Setup Dialog Box

OBIJECTIVE 14: INSERT A HEADER AND FOOTER 48
OBJECTIVE 6: USE TEMPLATES AND APPLY THEMES 24 Insert a Footer. Insert a Header
Open a Template, Apply a Theme OBJECTIVE 15: PREVIEW AND PRINT A FILE 49
OBJECTIVE 7: MODIFY TEXT 26

Preview a File, Print a File

HANDS-ON EXERCISE 3:
Modify Document Layout and Properties 51

Select Text, Edit Text, Use the Mini Toolbar, Use
Format Painter

CASE STUDY | Spotted Begonia Art Gallery =

You are an administrative assistant for Spotted Begonia, a local art gallery. The gallery does
a lot of community outreach and tries to help local artists develop a network of clients
and supporters. Local schools are invited to bring students to the gallery for enrichment
programs.

As the administrative assistant for Spotted Begonia, you are responsible for overseeing
the production of documents, spreadsheets, newspaper articles, and presentations that will
be used to increase public awareness of the gallery. Other clerical assistants who are familiar
with Microsoft Office will prepare the promotional materials, and you will proofread, make
necessary corrections, adjust page layouts, save and print documents, and identify appropri-
ate templates to simplify tasks. Your experience with Microsoft Office 2016 is limited, but
you know that certain fundamental tasks that are common to Word, Excel, and PowerPoint
will help you accomplish your oversight task. You are excited to get started with your work!




Taking the First Step
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FIGURE I.1I Spotted Begonia Art Gallery Memo and Flyer

CASE STUDY | Spotted Begonia Art Gallery
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Getting Started with Office
Applications

Organizations around the world rely heavily on Microsoft Office software to produce
documents, spreadsheets, presentations, and databases. Microsoft Office is a produc-
tivity software suite including a set of software applications, each one specializing in a
particular type of output. You can use Word to produce all sorts of documents, includ-
ing memos, newsletters, forms, tables, and brochures. Excel makes it easy to organize
records, financial transactions, and business information in the form of worksheets.
With PowerPoint, you can create dynamic presentations to inform and persuade audi-
ences. Access is a relational database software application that enables you to record and
link data, query databases, and create forms and reports.

You will sometimes find that you need to use two or more Office applications to pro-
duce your intended output. You might, for example, find that an annual report docu-
ment you are preparing in Word for an art gallery should also include a chart of recent
sales stored in Excel. You can use Excel to prepare the summary and then incorporate
the worksheet in the Word document. Similarly, you can integrate Word tables and Excel
charts into a PowerPoint presentation. The choice of which software applications to use
really depends on what type of output you are producing. Table 1.1 describes the major
tasks of the four primary applications in Microsoft Office.

Office 2016 Product Application Characteristics

Word processing software used with text to create, edit, and format
Word documents such as letters, memos, reports, brochures, resumes, and
flyers.

Spreadsheet software used to store quantitative data and to perform
Excel accurate and rapid calculations with results ranging from simple budgets
to financial and statistical analyses.

Presentation graphics software used to create slide shows for
PowerPoint presentation by a speaker, to be published as part of a website, or to
run as a stand-alone application on a computer kiosk.

Relational database software used to store data and convert it into
information. Database software is used primarily for decision making by
businesses that compile data from multiple records stored in tables to
produce informative reports.

Access

Pearson Education, Inc.

As you become familiar with Microsoft Office, you will find that although each soft-
ware application produces a specific type of output, all applications share common fea-
tures. Such commonality gives a similar feel to each software application so that learning
and working with Office software products is easy.

In this section, you will learn how to open an application, log in with your Microsoft
account, and open and save a file. You will also learn to identify features common to Office
software applications, including interface components such as the Ribbon, Backstage view,
and the Quick Access Toolbar. You will experience Live Preview. You will learn how to get
help with an application. You will also learn how to search for and install Office add-ins.

Starting an Office Application

Microsoft Office applications are launched from the Start menu. Click the Start button,
and then click the app tile for the application in which you want to work. If the applica-
tion tile is not on the Start menu, you can open the program from All apps, or alterna-
tively, you can click in the search box on the task bar, type the name of the program, and
press Enter. The program will open automatically.

* Office 2016 Common Features



Change Your Microsoft Account

Although you can log in to Windows as a local network user, you can also log in using
a Microsoft account. When you have a Microsoft account, you can sign in to any
Windows computer and you will be able to access the saved settings associated with
your Microsoft account. That means the computer will have the same familiar look that
you are used to seeing on other computers and devices. Your Microsoft account will
automatically sign in to all of the apps and services that use a Microsoft account as
the authentication. You can also save your sign-in credentials for other websites that
you frequently visit. If you share your computer with another user, each user can have
access to his own Microsoft account; you can easily switch between accounts so you
can access your own files.

To switch between accounts in an application such as Word, complete the
following steps:

1. Click the profile name at the top-right of the application.

2. Select Switch account. Select an account from the list, if the account has already been
added to the computer, or add a new account.

Logging in with your Microsoft account also provides additional benefits such as
being connected to all of Microsoft’s resources on the Internet. These resources include
a free Outlook email account and access to OneDrive cloud storage. Cloud storage is a
technology used to store files and to work with programs that are stored in a central loca-
tion on the Internet. OneDrive is an app used to store, access, and share files and folders.
It is accessible using an installed desktop app or as cloud storage using a Web address. For
Office applications, OneDrive is the default location for saving files. Documents saved in
OneDrive are accessible from any computer that has an Internet connection. As long as
the document has been saved in OneDrive, the most recent version of the document will
be accessible when you log in from any computer connected to the Internet. Moreover,
files and folders stored on the computer’s hard drive or saved on a portable storage device
can be synced with those on the OneDrive account.

OneDrive enables you to collaborate with others. You can easily share your docu-
ments with others or edit a document on which you are collaborating. You can even
work with others simultaneously on the same document.

Working with Files

When working with an Office application, you can begin by opening an existing file that
has already been saved to a storage medium, or you can begin work on a new file. When
you open an application within Office, you can select a template to use as you begin work-
ing on a new file.

Create a New File

After opening an Office application, such as Word, Excel, or PowerPoint, you will be pre-
sented with template choices. Click Blank document (workbook, presentation, etc.) to
start a new blank file. Perhaps you are already working with a document in an Office
application but want to create a new file.

To create a new Office file, complete the following steps:

1. Click the File tab and click New.
2. Click Blank.

Getting Started with Office Applications ¢



Open a File

You will often work with a file, save it, and then continue the project at a later time.
To open an existing file, you can click a location such as This PC or OneDrive and navi-
gate to the folder or drive where your document is stored. Once you make your way to the
file to be opened, double-click the file name to open the file (see Figure 1.2).

To open a file, complete the following steps:

+ 0 »

OneDrive - Personal

opiering 6@ vetiect com

This PC

Add a Place

Browse

1. Open the application.
2. Click Open Other Documents (Workbooks, etc.).
3. Click the location for your file (such as This PC or OneDrive).
4. Navigate to the folder or drive and double-click the file to open it.
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FIGURE 1.2 The Open Dialog Box

 Office 201

Office simplifies the task of reopening the file by providing a Recent documents list
with links to your most recently opened files. Previously saved files, such as the data files
for this book, are available in the Recent documents list, shown in Figure 1.3. If you just
opened the application, the recent list displays at the left. If you do not see your file listed,
you can click the link to Open Other Documents (or Workbooks, Presentations, etc.)

To access the Recent documents list, complete the following steps:

1. Open the application.
2. Click any file listed in the Recent documents list to open that document.

The list constantly changes to reflect only the most recently opened files, so if it has
been quite some time since you worked with a particular file, you might have to browse
for your file instead of using the Recent documents list to open the file.

6 Common Features



Recent documents list
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TIP: KEEPING FILES ON THE RECENT DOCUMENTS LIST

The Recent documents list displays a limited list of only the most recently opened files. You might,
however, want to keep a particular file in the list regardless of how recently it was opened. In

Figure 1.3, note that the Pin this item to the list icon displays to the right of each file. Click the icon
to pin the file to the list. At that point, you will always have access to the file by clicking the File tab

and selecting the file from the Recent documents list. The pushpin of the “permanent” file will change
direction so that it appears to be inserted, indicating that it is a pinned item. If later you want to
remove the file from the list, click the inserted pushpin, changing its direction and allowing the file to be
bumped off the list when other, more recently opened, files take its place.

FIGURE 1.3 Recent Documents List

G

Save a File

Saving a file enables you to later open it for additional updates or reference. Files are saved
to a storage medium such as a hard drive, CD, flash drive, or to the cloud on OneDrive.

The first time that you save a file, you should indicate where the file will be saved and
assign a file name. Of course, you will want to save the file in an appropriately named
folder so that you can find it easily later. Thereafter, you can quickly save the file with the
same settings, or you can change one or more of those settings, perhaps saving the file to
a different storage device as a backup copy. Figure 1.4 shows a typical Save As pane for
Office that enables you to select a location before saving the file.

It is easy to save a previously saved file with its current name and file location; click
the Save icon on Quick Access Toolbar. There are instances where you may want to
rename the file or save it to a different location. For example, you might reuse an event
flyer for another event and simply update some of the details for the new event.

Getting Started with Office Applications ¢



To save a file with a different name and/or file location, complete the
following steps:

Click the File tab.
Click Save As.

Select a location or click Browse to navigate to the desired file storage location.
Type the file name.

S I

Click Save.
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FIGURE 1.4 Save As in Backstage View

As previously mentioned, signing in to your Microsoft account enables you to save
files to OneDrive and access them from virtually anywhere. To save a file to your OneDrive
account follow the same steps as saving a file to your hard drive but select OneDrive
and then the desired storage location on your OneDrive. You must be connected to the
Internet in order to complete this action.

Using Common Interface Components

When you open any Office application you will first notice the title bar and Ribbon. The
title bar identifies the current file name and the application in which you are working.
It also includes Ribbon display options and control buttons that enable you to mini-
mize, restore down, or close the application window (see Figure 1.5). The Quick Access
Toolbar, on the left side of the title bar, enables you to save the file, and undo or redo edit-
ing. Located just below the title bar is the Ribbon. The Ribbon is the command center of
Office applications. It is the long bar located just beneath the title bar, containing tabs,
groups, and commands.

* Office 2016 Common Features
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FIGURE 1.5 The Title Bar and Quick Access Toolbar

Use the Ribbon

The Ribbon is composed of tabs. Each tab is designed to appear much like a tab on a file
folder, with the active tab highlighted. The File tab is located at the far left of the Ribbon.
The File tab provides access to Backstage view which contains Save and Print, as well as
additional functions. Other tabs on the Ribbon enable you to modify a file. The active tab
in Figure 1.6 is the Home tab.
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FIGURE 1.6 The Ribbon
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Office applications enable you to work with objects such as images, shapes, charts,
and tables. When you include such objects in a project, they are considered separate
components that you can manage independently. To work with an object, you must select
it. When you select an object, the Ribbon is modified to include one or more contextual
tabs that contain groups of commands related to the selected object. Figure 1.7 shows
a contextual tab related to a selected picture in a Word document. When you click away
from the selected object, the contextual tab disappears.
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FIGURE 1.7 A Contextual Tab
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